(W ) Creating Complex Formulas

Excel 2010

When you create worksheets that contain many calculations, you often need to create formulas that
contain more than one mathematical operator. For instance, to calculate profits for a particular product,
a formula would first need to calculate product sales (product price multiplied by number of products
sold) and then subtract costs from that result. Formulas that contain more than one operator are called
complex formulas. When a formula contains multiple operators, Excel uses standard algebraic rules to
determine which calculation to perform first. Calculations in parentheses are always evaluated first. Next,
exponential calculations are performed, then multiplication and division calculations, and finally addi-
tion and subtraction calculations. If there are multiple calculations within the parentheses, they are per-
formed according to this same order. Table H-1 lists the common mathematical operators and the order
in which Excel evaluates them in a formula. m Serena provides you with a worksheet showing
January and February sales for the western region and year-to-date returns. She asks you to add a new
column that calculates the adjusted sales total for both months. -

QUICK TIP

You can also
double-click the fill
handle to copy the
formuia to the range
F7:F13.

TABLE H-1: Review 0

1. Start Excel, open the file H-1.xlsx from where you store your Data Files, then save it as
H-Western Region Sales
A copy of Serena's partially completed worksheet is open and saved with a new name.

2. Click cell F6

You need M&r a formula in this cell that calculates Brenda Simpson’s total sales for January (cell C6) and
February (cell D6), then subtracts Brenda’s returns (cell E6).

3. Type@ click cel@ press @lick c@, pres@, click ce@ then click the Enter
button & ' U
See Figure H-1. The formula bar displays the formula =C6+D6-E6, and cell F6 displays the formula result, $33,575.
This formula added the value in cell C6 (Brenda’s January sales) to the value in cell D6 (Brenda's February sales),
then subtracted the value in cell E6 (the returns). In effect, Excel calculated §22,045+$13,876-$2,346. Now you need
to copy the formula to the range F7:F13, to calculate the total sales less returns for the other sales reps.

4. Drag the cell F6 fill handle pointer =+ down through cell F13 to copy the formula to the
range F7:F13
The results of the copied formula appear in cells F7 through F13, as shown in Figure H-2.

5. Click the Save button i on the Quick Access Toolbar
Excel saves your changes to the workbook.
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[‘mreference $B$16 for the commission rate in the formula.
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References

When you copy a formula from one cell to another, Excel automatically adjusts the cell references in the
copied formula to reflect the new formula location. For example, a formula in cell D5 that reads “=B5*C5"
changes to “=B6*C6” when you copy the formula to cell D6, As you learned in Unit G, a relative cell refer-
ence changes when you move it, to reflect its relative location to the new cell. There may be times when you

want a cell reference in a formula to refer to a specific cell, even when you copy the formula to a different

cell. In this case, you use an absolute cel| reference in the formula. An absolute cell reference is a cell
reference that always stays the same, even when you copy a formula tMcation. An
absolute cell reference contains § symbol before the column letter and row number (such as(SA$T)) To
insert an absolute cell reference in a formula, click the cell You want to use as an absolute refererce, then

QUICK TIP
The [F4] key is a
toggle key—press it
to change a relative
cell reference to an
absolute cell refer-
€nce; press it again
to change an abso-
lute cell reference
fo a relative cell
reference.

A
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1. Click cell G6

You need to enter a formula in this cell that calculates Brenda Simpson’s commission, The formula needs to

multiply the commission rate contained in cell B16 (5%) by the Total Sales Less Returns value in cell F6. You
begin the formula by entering the absolute cell reference $B$16,

2. Type =, click cell | B16, then press [F4

The formula bar and cel] G6 display =$B§16. Pressing [F4] automatically added two $ symbols to the B16 cell
reference to format it as an absolute cell reference. Now you need to complete the formula,

3. Type*, then click cell Fg

The formula bar and cﬁdisplay the formula =$B$16*F6, as shown in Figure H-3. Cells B16 and F6 are
highlighted because they are referenced in the formula,

4. Click the Enter button
Cell G6 shows the formula result of 1678.75, the commission amount for Brenda Simpson. You need to apply

————1the Accounting number format to the cell and round to the nearest whole number,

5. Click the Accounting Number Format button in the Number group, then click the
Decrease Decimal button [3%/in the Number group twice

The value in cell G6 is now formatted as currency with no decimal places. You need to copy the formula to
the range G7:G13, to calculate the commission amounts for the other sales Ieps.

6. Double-click the cell G6 fill handle = to copy the formula to G7:G13
Double-clicking the fill handle automatically filled cells G7:G13. Double-clicking a fill handle automatically
fills adjacent cells down a column or across a row; this method can be faster and more efficient than dragging
the fill handle. Now cells G6:G13 display the commission amounts for all the sales Ieps.

7. Click cell G7, then save your changes
As shown in Figure H-4, the formula bar displays =$B$16*F 7, which is the formula for cell G7, Notice that the
formula contains the absolute cel] reference $B$16; it was copied exactly from cell G6, The other cel] reference

in the formula, F7, is a relative cel] reference, which changed when the formula was copied to cell G7. Cell G7
displays the value $2,3 11, the commission for Grace Holmes,
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Using Date and Time
Functions

There are many categories of functions in Excel. See Table H-2 for a list of common ones. The Excel date
and time functions let you display the current date and/or time in your worksheet and can help you cal-
culate the time between events. Some date and time functions produce recognizable text values that you
can display as is in your worksheets. Other date and time functions produce values that require special
formatting. M Serena wants the Western Region Sales worksheet to calculate the date that commis-
sion checks are scheduled to be issued. To accomplish this, you decide to use the TODAY function to enter
the current date in the worksheet, and enter a formula that uses this information to calculate the check
issue date, which is 30 days from today.

The TODAY function

uses your comput-

er's internal clock to

i return current date
b information, and

| recalculates this

result as needed.

g U'ES(\‘ m”

| v

category
. Financial ,
I:ﬁgicalu -
- Text hm 7
) ’l?ate & Time

Math & Trig

Lookup & Reference _

1. Click cell B3
This cell is to the right of the label Today’s Date. You want to enter a function in this cell that returns today’s date.

2. Click the Date & Time button in the Function Library group
The list of date and time functions opens. You can point to any item to view a ScreenTip that describes the
purpose of that function.

3. Point ta TODAY in the list of functions, as shown in Figure H-8, then click it
The Function Arguments dialog box opens, as shown in Figure H-9. The description in the dialog box explains

that the TODAY function returns the current date. It also explains that the TODAY function requires no
arguments, so you will not need to add values between the parentheses in the formula.

4. Click OK

The result of this function, the current date, appears in cell B3.

—

5. Click cell B1§

You want to enter a formula in this cell that returns the date that is 30 days from the date in cell B17, which
was the closing date for February.

6. Typg@res@o select cell B17, then type @

The formula youw€ntered, =B17+30, calculates the day w!en commission checks are issued, which is 30 days
after the date in cell B17 (2/28/2013).

7. Click the Enter button [ on the formula bar, then save your changes
The commission due date (3/30/2013) appears in cell B18, as shown in Figure H-10.

TABLE H-2: Categories of common worksheet functions

used for includes
Loan pa)}ments, a’prpreciation, and depreciation PMT, FV, DB, SLN i
Calculaﬁtgoﬁ;thaﬂt di_sp.lz;y avalue ifa con‘cﬁi‘iti‘on&iﬂs_metl ‘ IF, AN D,‘NOT ) -
'-Eghwﬁ';ring, ﬂéérln\;'e&ing, and reforur'r;'étt'i-ﬁg text strings in cells FIND, REPLACE
Calculations involving dates and times  NOW,TODAY, WEEKDAY

_‘ Findihg values in lists or tables or flndlng cell referen_c.es- __' _‘ _ADWDFEESS', ROW, COLUMN - B
Sim}}le and ccu}-mplex mathematical calculations a ABS,ASIN, cos
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Using Statistical Functions

Excel includes many statistical functions that let you assemble, classify, and tabulate numeric data. The most
popular statistical functions, AVERAGE, MIN, and MAX, are available on the AutoSum list arrow. You can cal-
culate the averagé of a range of cells using the AVERAGE function, and you can identify the smallest or larg-
est value in a range of cells using MIN or MAX. These functions are also available under Statistical in the
More Functions category of the Function Library on the Formulas tab, and you can also access them using the
Insert Function dialog box. ﬂ Serena wants you to include the average sales amounts for each month in
the Western Region Sales worksheet. She also wants you to indicate the largest and smallest order amounts
for the whole region. You decide to use functions to add the necessary calculations to the worksheet.

1. Click cell B19, click the More Functions button in the Function Library group, point to
Statistical, then clic age )
The Function Arguments dialog box opens. You use this dialog box to specify the arguments you want to
include in the function. In this case, you need to specify the range of cells C6:C13 for January sales.

2. Select the range C6:C13, as shown in Figure H-11; then click OK in the Function
Arguments dialog box
The formula =AVERAGE(C6:C13) is entered in the formula bar. The active cell (B19) displays the result of the
formula ($22,323). This is the average sales amount among the sales reps for January, Next you need to enter
a formula in B20 that calculates the average for February sales.

3. Click cell B20, click the AutoSum list arrow in the Function Library group, then click Average

You can also use the
MAX function by
clicking More
Functions in the
Function Library
group, pointing to
Statistical, clicking
MAX, selecting the
range you want

in the Function
Arguments dialog
box, then

You can include one
function as an argu-
ment in another
function if its result
is compatible. For
example, the for-
mula =SUM(C25,
AVERAGE(C6:C13))
adds cell C25 to the
average of the cell

range C7:C25.

 Using the status bay t6 view average and sum data

Notice that Excel automatically highlights cell B19. Excel is guessing that you want to calculate the average of
the cells containing numbers directly above the active cell. This is not what you want to do; you want to
calculate the average February sales amounts in the range D6:D13.

4. Select the range D6:D13, then click the Enter button [%] on the formula bar
The average sales amount for February ($21,664) now appears in cell B20. The formula =AVERAGE(D6:D13)

appears in the formula bar. Now you need to enter a formula in cell B21 that returns the highest sales amount
in both months.

5. Click cell B21, click the AutoSum list arrow in the Function Library group, then click Max

Notice that Excel automatically highlights cells B19 and B20. Excel is guessing that you want to calculate the
average of the cells containing numbers directly above the active cell (819 and B20). This is not what you
want to do; you want to find the highest sales amounts in the range C6:D13.

clicking OK. P> 6. Select the range C6:D13, then click

The formula =MAX(C6:D13) appears in the formula bar, as shown in Figure H-12. The active cell B21 displays
the formula’s result ($36,541), which is the largest sales amount. This amount, found in cell (8, is the January
sales for Jose Garcia.

7. Click cell B22, click the AutoSum list arrow in the Function Library group, click Min,_select
the range C6:D13, click ], then save your changes to the workbook =
The formula =MIN(C6:D13) appears in the formula bar, as shown in Figure H-13. This formula returns the
smallest value contained in the cell range C6:D13. The active cell B22 displays the formula’s result (§10,967),
which is the smallest sales amount. This amount, found in cell D9, is the February sales for David Chung.

The status bar provides information on average and sum on any the sum of selected cells. The status bar also displays a value for

5&/ s%ggd.rggge. When a range of cells containing values is selected, 5 ggggt which represents the number of cells selected.

the status bar di‘splays data for the average of the selected cells and
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Applying Conditional
Formatting

Sometimes you might want to.highlight certain cells in a worksheet that contain significant data points. For
instance, if your worksheet lists customer orders, you might want to highlight the cells containing orders

that exceed a certain amount. If your worksheet shows product sales, you might want to highlight cells
containing the highest and lowest product revenues. Instead of manually formatting each highlighted cell,
you can use conditional formatting. Excel applies conditional formatting to cells when specified criteria
.are met. For instance, you could apply green, bold formatted text as conditional formatting to all sales
orders greater than $50,000. You can specify your own customized conditional formats, or you can use one
of the built-in conditional formatting options available in Excel 2010, such as data bars, color scales, and
icon sets. m Serena wants the worksheet to highlight the high and low total amounts in the Western
Region Sales worksheet. You explore different conditional formatting options to find the right effect.

You can apply red,
yellow, and green
icons as conditional
formats to indicate
high, medium, and
low values in a
selected range. Click
the Conditional
Formatting button,
paint to lcon Sets,
then click the icon
set you want.

To specify your own
custom formatting
choices in the Less
Than dialog box,
click Custom Format
in the drop-down
list, choose the
options you want in
the Format Cells

dialog box, then
click OK.

S S

QUICKTIP 6.

1. Click the Home tab, then select the cell range 56:F13
You selected the cells in the Total Sales Less Returns column. These cells display the total sales amounts for
each rep (minus returns).

2. Click the Conditional Formatting button in the Styles group, point to Color Scales, then
click the Green - Yellow - Red Color Scale option (first option, top row), as shown in
Figure H-14
Color scales are shading patterns that use two or three colors to show the relative values of a range of cells.
The selected cells now contain shading gradations of three different colors. The green shades highlight the cells
containing the higher values; the yellow shades highlight the values in the middle, and the red shades high-
light the lower values. You decide to remove this shading so that you can explore other conditional formats.

3. Click the Conditional Formatting button in the Styles group, point to Clear Rules, then

click Clear Rules Selected Cells

~— With all the conditional formatting rules cleared, the color scales no longer appear in the selected cells.

4, Click the Conditional Formatting button, point t%, then click the Green Data
Bar option in the Gradient Fill section, as shown in Figure H-15 '
The cells in the selected range now contain green shading. The cells with the highest values have the most
shading, and the cells with the lowest values have the least. Data bars make it easy to quickly identify the

-~ large and small values in a range of cells and also highlight the relative value of cells to one another.

5. Select cells C6:D13, click the Conditional Formatting button, point to Highlight Cells
__Rules, then click Less Than
The Less Than dialog box opens. You decide to apply shaded red highlighting to cells containing values less

than §$15,000.

Type_ 15000 in the Format cells that are LESS THAN text box, compare your screen to
Figure H-16; then click OK '

The cells containing values less than $15,000 in cells C6:D13 are now shaded in red, making it easy to pick
out the lowest sales amounts. It is now easy to see that David Chung’s sales for January and February and
Brenda Simpson's sales for February are less than $15,000.

~ 7. Save your changes to the worksheet
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Excel 2010

Sorting Rows in a Table

Excel lets you analyze a separate range of worksheet data called a table, or rows and columns of data with
-asimilarstructure. When you designate a cell range as a table, you can manage and analyze its data sepa-
rately from other parts of the worksheet. For instance, you cag’sort,Jor change the order of the table rows,
by specifying that the rows be arranged by a particular column in the table. An Excel table is similar to a
-lable in a database because you can sort data in much the same way. As in database tables, Excel table
columns are often called fields (such as a Last Name field), and rows of data are called records (suchasa
record for each customer). You use the Format as Table button in the Styles group to specify the cell range
for the table and an appropriate table style. SS9 Serena wants the data sorted by state—alphabetically—
and then within each state by total sales amount from largest to smallest. You format the data as a table in

ﬂorder to sort it.

QUICK TIP
To remove the
header row, deselect
the My table has
headers check box.

TROUBLE
Remember that the
fill handle is in the

lower-right corner of
cell G14. Drag the
fill handle to the left
to cell C14, just as
you would drag it
down to fill a col-
umn or to the right
to fill a row.

—

To undo the results
of a sort immediately
after performing it,
click the Undo but-
ton on the
Quick Access toolbar.

perform other com-
mon calculations,
such as Average,
Min, or Max. Click
the Total row cell
you want to change,
click the down
arrow, then click the
function you want,
—

You can use the
Total row cells to

1. Click cell AS, click the [Format-as-Fable button-in-the Styles group, then click Table Style
—Light 9 (second style in the second row), as shown in Figure H-17
Notice that a dotted border surrounds the range A5:G13; this is the range that Excel assumes you want to
format as table. The Format As Table dialog box is also open, with the range A5:G13 specified. The ‘My table

has headers’ check box is selected. In a table, the header row is the row at the top that contains column
headings.

2. Click OK, then click any cell in the table
The Tables dialog box closes, and the range you selected is now defined as a table. Notice that each cell in the
header row contains a list arrow@ on its right edge. On the Table Tools Design tab in the Table Style Options
group, notice that the Total Row check box is deselected. A total row is an extra row at the bottom of a table
that Excel adds. You want to add a Total row to the table.

3. Click the Total Row check box in the Table Style Options group

Row 14 now contains a Total label (in cell A14). By default, the last cell in the Total row contains the
SUBTOTAL function, which calculates the sum total of the table’s last column of data. Cell G14 now shows

the subtotal of the Commissions (for the range G6:G13).

4. Click cell G14, position the pointer over the fill handle in the lower right corner of
cell G14 until it changes to +, then drag = to cell €14
You copied the formula that summed cells G6:G13 from cell G14 to cells C14:F14. Now cells C14:G14 display
_ the sum totals for the data in columns C through G.

5. Click the State list arrow =] in cell B5, then click Sort A to Z, as shown in Figure H-18
The items inmw state in alphabetical order, with the Arizona reps at the top and the
Washington reps at the bottom. Notice that there is now a small Up arrow to the right of the list arrow in cell
BS, indicating that this column is sorted in ascending order (or smallest to largest). Serena also wants the list
to be sorted by totals within each state, from largest to smallest.

6. Click the Home tab, click the Sort & Filter button in the Editing group, then click w

The Sort dialog box opens. Because you already performed one sort on this data, your sort criteria is lsted in
the dialog box. You can use this dialog box to sort on up to three levels,

7. Click Add Level, click the Then by list arrow, click Total Sales Less Returns, click the Order

list arrow, click Largest to Smallest, compare your screen to Figure H-19, then click OK
The list is now sorted first by the State column in alphabetical order. Within each State listing, the cells
containing the highest value in the Total Sales Less Returns column are listed first, as shown in Figure H-20.

8. Save your changes
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N‘M

% | Filtering Table Data

If your Excel table contains a large amount of data, you might want to filter it to display only the data you
need. Applying a filter tells Excel to show only those rows that meet specific requirements, such as custom-
erswith a pamcular zip code, or orders that exceed a certain dollar amount. When you tell Excel which rows
in a table you want To see, you are specifying the criteria for your filter. Just as when you sort data in a
table, you can apply a filter to a table by using theTilter ist arrows that appear to the right of each column
heading. Unlike a sort, a filter does not change the order of the items in your table; instead, it temporarily
hides the rows that do not meet your criteria. m Serena wants you to filter the table data so that it
shows only the sales reps for California and Washington State whose sales amounts are less than $50,000.

.l
=E

QUICK TIP
To remove an
applied filter, click
the Sort & Filter

button in the Editing
group, then click
Filter.

range, right-click any-
where in the table,
point to Table, click
Convert to Range,

then click Yes.
Y r—————————iey

You can also adjust
how pages break in
Page Break view.
Click the Pag'ﬁieak
View button |l
on the status bar,
then drag the blue
page break lines to
where you want the

breaks to occur.
oo e

Excel 186

To change a table L
back to a normal

N ouickTiP

1. Click the State list arrow in cell BS
The filter drop-down list opens and displays the list of available filters for this column. Excel creates filters for
each of the values in the column, plus filters to automatically select all values, custom values, specified text,
or numeric values. You can even filter a table by cell color.

2. Click the (Select All) check box

The check marks are now removed from all the check boxes. You want to check the CA and WA check boxes,
to specify that rows containing CA or WA in the States column display.

3. Click the CA check box, click the &\check box, compare your screen to Figure H-21, then

click OK
You have applied a filter that shows only the rows that contain the values CA and WA in the State column

five rows). You can tell that the table is filtered because the arrow in the column header contains a filter icon
'*T and the row numbers have breaks in their numeric sequence.
ick the Total Sales Less Returns list arrow in cell F5, point to Number Filters, then click

Less Than
The Custom AutoFilter dialog box opens. You use this dialog box to specify one or more criteria for a filter.
The list box below Total Sales Less Returns displays “is less than,” and the insertion point is in the box where

you need to specify an amount.

5. Type 50000, compare your screen to Figure H-22, then click OK
The table is filtered to show sales reps whose Total Sales Less Returns amounts are less than $50,000, as shown
in Figure H-23. Now the table displays only four rows. By using the filter drop-down arrows in succession like
this, you can apply more than one criterion to the same data in your table.

6. Type your name in cell A25

7. Click the File tab, then click Print
The Print tab is now open and the worksheet appears in the Preview pane You can see that the last two
columns in the worksheet (Total Sales Less Returns and Commission) do not fit on the page. You can fix this

by changing the Scalifig settings Iy the Settings area.
8. Click the in the Settings area, then click Fit Sheet on One Page
The worksheet shrinks down just enough so that all the columns fit on the page, as shown in Figure H-24.
9. Save your changes, close the worksheet, exit Excel, then submit the completed worksheet
to your instructor
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Select the best answer from the list of choices.

12. Which of the following is a complex formula?

a. =SUM(A2:A10) ¢. =F2+1400
b. =(E2+E3)*.20 d. =MIN(A7:24)
13. In a complex formula, which of the following is evaluated first?
a. - Subtraction ¢. * Multiplication
b. + Addition d. () [tems in parentheses

14. Which of the following functions is correctly structured and calculates the sum of 77 plus the values in
cells A7, A8, and A9?

a. =SUM(77,A7,A8) c. =SUM(77,A7,A9)
b =SUM(77:A7-A9) d. =SUM(77,A7:A9)
15. In the formula =MIN(D5:D6, E8:F10), which of the following are the arguments?
: a. D5, D6, E8, and F10 ¢. D5:D6 and E8:F10
b. D5 and E8 d. E8:F10, D5
[ 16. Which of the following functions returns the value 2013?
a. =MAX(4,10,2013, 2103) c. =MIN(2013, 2011)
} b. =AVERAGE(4,10,2013) d. =SUM((1000*2)+13) m
) 17. What value would Excel return in calculating the formula =SUM(5,MIN(1,5,7))? g
a. 6 c 12 ~
) b. 18 d. 10 =
18. What value would Excel return in calculating the formula =MAX(8,(2*3),100,(90+12),50)? =
a. 150 ¢ 50
b. 100 d. 102

19. If you want an Excel table to display only rows containing values less than 50 in the Revenue column,
which of the following actions should you take?
a. Choose the 50 filter on the Revenue column filter list.
b. Sort the rows from smallest to largest in the Revenue column filter list.
c. Sort the rows from smallest to largest in the Revenue column filter list.
d. Use the Custom AutoFilter dialog box to specify to show only rows in which the Revenue field is less than 50.

Skills Review

1. Create complex formulas
a. Start Excel, open the ﬁl from where your Data Files are stored, then save it as H-May Orders.
b. Enter a complex formula Irtéll G6 that calculates the sum of cells D6 and E6 minus the value in cell F6.
c. Copy the formula from cell G6 to the range G7:G14.
d. Save your changes to the workbook.
2. Use absolute cell references.
a. In cell H6, enter a formula that multiplies the value in cell D6 by the value in B17, using an absolute cell reference for B17.
b. Use the fill handle to copy the formula in cell H6 to cells H7:H14.
c. Save your changes to the workbook.
3. Use date and time functions.
a. Use the TODAY function to enter today’s date in cell B22.
b. Enter a formula in cell J6 that calculates the date that is 30 days later than the Order Date for Harold's Tea Shop.
¢. Use the fill handle to copy the formula in cell J6 to cells J7:J14.
d. Save your changes to the workbook.

)
’
)
:
)
)
)
3
3
2
3
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Skills Review (continued)

4. Use statistical functions.

a. Enter a formula in cell B18 that uses the AVERAGE function to determine the average May order amount for the range
D6:D14.
b. Enter a function in cell B19 that determines the smallest May order amount for the range D6:D14.
¢. Enter a function in cell B20 that determines the largest May order amount for the range D6:D14.
d. Save your changes to the workbook.
- Apply conditional formatting.
a. Select the range D6:D14,
- Apply a Color Scales conditional formatting to the selected range, choosing any style you like.
Clear the conditional formatting rules you applied in Step 5b.
- Apply Gradient Fill Blue Data Bars conditional formatting to the range D6:D14.
Select the range G6:G14, then apply conditional formatting to the cells in this range, specifying that all cells contain-
ing values that are greater than 1000 be formatted in Light Red Fill with Dark Red Text.
f. Save your changes to the worksheet.
. Sort rows in a table.
a. Format the cell range A5:J14 as a table, applying Table Style Light 11 (fourth style in second row of Table Styles gallery).
b. Specify to add a Total row to the table. Delete the value in cell J15 of the Total row (because it is a date). Click the cell
D15 down arrow, then click Sum.
¢. Drag the cell D15 fill handle to cell H15.
d. Sort the table in alphabetical order by Town.
e. Use the Sort dialog box to sort the list data first by Town in alphabetical order, then by May Order Amount in largest to
smallest order.
f. Save your changes to the workbook.
. Filter table data.
a. Apply a filter so that only the rows containing Bay City and Gulfwood appear.
b. Apply a custom filter to the filtered table that displays only those items whose Balance Due amount is greater than
$500.
¢. Enter your name in cell A25 of the worksheet.
d. View the worksheet in Print Preview, change the orientation to landscape, then adjust the scaling so that all columns -
fit on one sheet.
e. Save your changes, close the worksheet, then exit Excel. Submit your completed worksheet to your instructor. Compare
your completed worksheet to Figure H-26.

I~ eI~ X

FIGURE H-26
Queen of Hearts Pastries
May Orders and Balances—Week 1
County Hospital 2254 BayCity WS Fra.00 5 54800 $ 548.00 1370 s 110.24 5/2/2013 6/1/2013;
The Bay Hotel 4456 BayCity WSS 1,086.00 § 65500 § 56800 5 115300 5 85.28 5/1/2013 5/31/2013
Kennedy Elementary School 1543 Quiwood WIS AWM S 75500 5 SG000 S 201000 § _ iagad _ sepol e S3(20131
Total % 4,299.00 § 1,958.00_§ 1,676,00 4,641.00 § 343.92 !
Delivery Fea: 8%
Average Order Amount: ] 629.67
Smaliest Order Amount: $ 143.00
Largest Order Amount: 3 1,855.00
Today's Date: 5/15/2013
Your Name
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Independent Challenge 2

The sales director at Wexler Organics, Inc,, has just received the raw sales data for the month of August. She has asked you to

finish creating a worksheet that she started. She wants you to highlight key information on this worksheet, including the high-

est individual sale, the overall sales total, and the number of sales reps who logged individual sales transactions greater than
$5,000 for the month.

a,

b.

Open the ﬁlsx from where you store your Data Files, then save it as H-August Sales Rep Report.
Enter a formula-irf cell E7 that calculates the commission owed to the rep. (Hint: Multiply cell D7 by the absolute refer-

ence B4.) Use the fill handle to copy the formula to cells E8:E39.
Create a formula in cell F7 that subtracts the rep’s commission in cell E7 from the Sales amount in cell D7.

d. Copy the formula in cell F7 to the range F8:F39.

Create a table from the range A6:F39. Apply a table design style that you like to the table. Include a Total row. Use the
fill handle to copy the formula in cell F40 to cells E40:D40.

Sort the table data by sales in order from largest to smallest, Look at the sorted list, then enter the name of the tep that
has the largest sales amount in cell B42.

» Select cell B43, then enter a formula that uses the MAX function to identify the highest individual sale in the month.

Apply the Accounting number format to cell B43 with no decimal places.

» Enter a formula in cell B44 that calculates the average for all sales in cells D7:D39. Apply the Accounting Number for-

mat, and remove all decimals.
Apply Data Bars conditional formatting to the range D7:D39, choosing any data bar color you like.
Enter your name in cell A3.

- Preview the worksheet in Backstage view. Adjust the scaling so that all columns fit on one sheet in portrait orientation.

Save your changes.
Save your changes, close the workbook, then exit Excel. Submit your completed worksheet to your instructor.

Independent Challenge 3

You own and operate The Last Minute Chef, a restaurant and caterer that serves busy families in Rochester, New York. You are
building an Excel spreadsheet to calculate your profits for the previous year. You have entered sales and most of the expense data
in the worksheet. Now you need to enter the necessary formulas to calculate the delivery costs and the profits for each month.

a.

b.

Boa e oa

e
.

Open the file H-5.xIsx from where you store your Data Files, then save it as H-Restaurant Profits. Enter your
name in cell A26.

The Last Minute Chef pays for food deliveries through a delivery service, which charges a $7.00 flat fee per delivery.
The delivery fee is in cell B20. Enter a formula in cell IS that calculates the cost of deliveries for the month of January.
(Hint. The formula needs to multiply cell H5—the cell that contains the number of deliveries for January—by cell B20,
with B20 as an absolute cell reference.)

Enter a complex formula in cell 5 that calculates profits for January. The formula should subtract the sum total of cells
C5:GS5 and cell IS from BS (Sales for January). (Hint: Start the formula with BS followed by the - mathematical operator,
followed by the SUM function to add C5:G5 and cell I5. You will need to use two sets of parentheses—one set around
the arguments, and the other around the whole SUM function part of the formula.)

. Select cells IS and J5, then use the fill handle to copy the formulas down the columns.

Enter a formula in cell B21 that identifies the highest profit amount.
Enter a formula in cell B22 that identifies the smallest profit amount.

. Enter a formula in cell B23 that calculates the average monthly profit for the entire year.
- Apply conditional formatting to the cells J5:J16 to format any cells containing values greater than 55000 with green fill

and dark green text.
Format the range A4:16 as a table, choosing any table style you like. Add a Total row. Use the fill handle to copy the
formula in cell J17 to cells I17:B17. -
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Visual Workshop

Open the fil¢H X and save it as H-Spring Classes Profits where you store your Data Files. Modify the worksheet so q
that it contai e formulas, functions, and formatting shown in Figure H-27. The Total Student Fees cells need to include

formulas that multiply the number of students by the student fee by the number of classes. The Instructor Cost cells need to 1
include formulas that multiply the number of classes by the instructor fee (875.00) inr cell B19. (Use an absolute cell reference.) -
The Profit cells need to subtract the Instructor Cost from the Total Student Fees. Convert the range A4:H16 to a table, then L
resize column widths to match the figure. Sort the table as shown. Enter appropriate formulas and labels in the range E19:E20 4
Change alignments to match the figure. Add your name to cell A21 Adjust the print settings to landscape orientation. Save
and close the workbook, exit Excel, then submit your finished workbook to your instructor. :;
G
FIGURE H-27 =
T
. s S5 ST O T RIS ot PR SRR SR T R | :
| . . (] @
; Fiesta Dance Studio
;2 o 7. U o Spring Classes Profits f -
£ | &
e No. of Student Fee per No. of Total Student Instructor ! b
R Class M Instructor B Classes class R Students BJ Fees MY Cost KJ Profit —
5 Balloom  Abbott iy, A 2 2. ¢ 5808 § o 5 4,508 ki
6 Tengo  Abbott 10 $ 2 265 570 3 750 § 4,970 i
7 Samba  Abboit 12 3 200 N2 B 5280 § 900 §  aam i
8 Rhumbs  Abbott 12 S 1 15 s 192§ 900 § 1,020 | -
9 ‘Ballet L s Lo o B e 900 § As00| I= -
10 Jaz Kids Moore 12 $ 8 30 s 2880 3 900 $ 1,980 | &
11 Tap Seln s P e 25 s 700 $ 900 § 6,300 | =
12 irish Step  O"Donnell 24 3 10 R E 6,720 $ 1,800 $ 4,920 ; o
13 Modem Zacks 24 5 12 24 5 6912 S 1,800 5 5112 i S
14 HipHop  Zacks 16 S 1w s 5376 $ 1,000 § 4,176 | i o
15 African DanceZacks 15 8 R R 3520 § 1200 § 2,320 | o<
16 {Haitian Zacks 10 $ 16 16 |3 2,560 § 750 §  igw0] I
17 [Total $  a3s3% i L2
Sellinstructorfee: (§ 700 Nemelpotel s Psesl o 1T :
0, C i ... Average class size: L
21 YourName S _ ;
T shests S T TR T e ¢ e e
e M e \\ L [T T n——y —)

Enter formulas
in these cells
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